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QuestView™ Learning Guide
Introduction to QuestView

QuestView is an easy-to-use, interactive database utility which allows you
to perform two major functions quickly. First, you can view and

update database files immediately, utilizing  a rich set of options that allow
you to alter how the records are presented. Secondly, you can generate
customized inquiry programs which can be incorporated into end-user
application systems. The object programs QuestView creates can be used
by programmers, or easily tailored for a user audience.

About This Learning Guide
This guide contains information to better acquaint you with the

functions and features of QuestView. It is not intended to serve as a
comprehensive User’s Manual. This guide has been designed to give a
general explanation of the Action Bar, screen displays, input-capable
fields, and function keys. Additionally, this guide could suitably serve
as a reference tutorial for staff who may require a brief introduction
to, or refresher of, QuestView and its fundamental capabilities.

What’s New in Release 9.0?
The most notable new features in QuestView 9.0 are our Undelete capability,

and our plug-in for Eclipse—based development environments. Previous releases
introduced Unicode support, and enhanced ASCII support. 

Typographical Conventions
Information typed or displayed on a terminal is shown in Swiss

Monospaced type. Keys on your keyboard, such as e, +  or
], are shown as KEYCAPS.

Getting Started
Before using this guide, verify that QuestView has been loaded onto

your system, and that the library AQUESTVIEW is in your library list.
If it is not present in your library list, add it temporarily by typing
the following command:

ADDLIBLE AQUESTVIEW

and see your system administrator about adding it permanently.

You are ready to begin working with QuestView. From any
Command Line, type the command:

VIEW VIEWCUS

and press e.
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The Single Record Data Screen
The screen you are currently viewing is the Single Record Data

Screen. Press e to remove the copyright notice.

The Function Keys located at the bottom of the display are
presented in sequential order, and follow SAA Common User Access
standards. All function keys specific to this screen can be displayed by
pressing the ] key. To display the Function Keys’ definitions, along
with general help for the screen currently displayed, press + .

The top portion of the screen contains the following input and
output fields:

Action Bar This is a standard pull-down menu bar, also conforming to CUA
guidelines. Available on both the single-record and multiple-record data
screens, it offers an easy method of performing most common QuestView
tasks. Use of the Action Bar is discussed in greater detail on page 6.

Page Number Pg: indicates the page of fields displayed. The screen shown above
is displaying page 1 of a two-page display. The “+” sign in the lower
right corner of the display also indicates more pages. To move to page
2, you can either type a 2 in the Pg: field, or press > to page forward.
By pressing <, you can move back to page 1. Under the Pg: field,
the screen mode is indicated. This screen shows “Display” mode.

File, Library,
and Member

File: specifies the name of the file selected for data display; Libr:
and Mbr: specify the Library in which the file is located, and the file
member, respectively. Entering a question mark (?) in the first position
of any of these fields, or pressing $ with the cursor on any of these
fields, will display a selection list. The type of file being shown is
indicated above the File: field. 

Format Fmt: indicates the format name for the file. If a logical file has
multiple formats, this field shows the format name of the record(s)
currently being displayed.
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Record
Number

Rec: indicates the relative record number of the current record. The
Roll/Page keys (p/q or ~/®, depending on your
terminal keyboard) will move through the records, and Function Keys
< and > will move through pages of fields. You can reverse these
functions via Options menu item number 3, Roll key controls... The Rec:
field cannot be used to perform positioning unless the file displayed
is in relative record number sequence.

VIEWCUS is a keyed file; its Customer Number key is shown
highlighted above all the file’s data fields. If no highlighted field
appears above the data, the file is in arrival sequence. The key field is
used to move between records in a keyed file. If no value is entered in
the field, the file is positioned at the record with the lowest key value.
It is possible to change from keyed file access to relative record number
access. Enter F into the Action Bar, and select item 2, By arrival access

path from the File menu. The Rec: field will become input-capable,
allowing access to records by their relative record number.

Scan Scan: allows you to scan for specific data in a field by entering a
value in the Scan: field and using / to scan forward, or : to scan
backward from the displayed record. If the scan criterion is not found,
the message “End of file reached; scan argument not found” will appear
and the last record searched will be displayed.

The File Data
The next section of the screen displays data fields and their

descriptions for the current record. The field descriptions are column
headings extracted from DDS if column headings were used when the
fields were created. If column headings were not used, the field text
would be substituted. If neither are available, field names are used.
Numeric fields are displayed in accordance with their Edit Code. Fields
may also be changed to display in hexadecimal format. Selecting Screen
Formatting from the Options menu will allow you to change the data
representation to hexadecimal, as well as changing a variety of other
display formatting options.

Display, Update, and Add Modes
While in Display mode (the default), fields cannot be updated. The

lines that appear under the data indicate field length only. To change
information in a record, press _ for Update mode. The word “Update”
will replace “Display” on your screen, and the data fields will become
input-capable.

To add records, enter Add mode by pressing (. Blank fields will
be presented for entry of new data. After typing in the data, press e
to add the record to the file.

To delete records, position yourself at the record to be deleted,
while in Update mode, and press \ to delete the record. A message
to confirm the deletion will appear; press \ again to confirm; press
e or = to abort the deletion.
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The Action Bar
Pressing ) from any location on the Data Screen positions the

cursor in the two-character Action Bar field.

If the cursor is positioned in the Action Bar when ) is pressed,
it will move to your file’s “Position To” field (either the highest order
key or the RRN field). Once positioned in the Action Bar field, enter
the first character of your desired action and press e. A menu will
drop down under the chosen action, allowing further selection. Your
second selection can be made in one of three ways: you can (1) enter
the number of your selection, (2) enter the mnemonic letter of your
selection, or (3) position the cursor on your selection and press e.

If the menu item you select is shown followed by an ellipsis (...), it
will then display a pop-up window (or full screen) dialog, allowing
entry of additional parameters. If it is shown without the ellipsis (e.g.
By arrival/keyed access path on the File menu), the selected action is
executed immediately, as it requires no parameters.

The Action Bar also allows you to select both menu and menu item
in one step by entering two characters in the Action Bar field. The first
character should represent the menu, while the second character should
be the number or mnemonic for the menu item. If your selection uses
a pop-up window dialog, QuestView will drop down the menu, with
your selection indicated, before acting on it; otherwise, it will simply
act on your selection immediately.

For example, entering O1 or OS in the Action Bar field would have
the same result as entering O in the Action Bar field and 1 or S in the
menu field: the Options menu would drop down, and the Screen
Formatting dialog window would appear.
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The Multiple Record Data Screen
By pressing - from the Single Record Data Screen, you can

change to the Multiple Record Data Screen.

This screen displays records vertically and fields horizontally. As
with the Single Record Data Screen, the Function Keys are displayed
at the bottom. However, some of these keys are different from those
available on the Single Record Data Screen. For example, \ (Delete)
does not appear because this function is handled differently on the
Multiple Record display.

The Pg: field indicates that there are four pages used to display all
the fields for this file. Just as with the Single Record display, Function
Keys < and > allow you to move backward or forward through
the pages of fields; one may also enter a page number in the Pg: field.
The Roll/Page keys are used to move through the records of the file;
once again, the Roll/Page functions and the </> functions can
be swapped using the Roll Key Controls item on the Options menu.

Individual records can be selected for display by typing a 1 in the
selection column field to the left of the record, and pressing e.
The selected record is then displayed on the Single Record Data Screen.
-  (Single Record) will also return you to the Single Record display.
Pressing ( (Add) from the Multiple Record display will return you
to the Single Record when entering Add mode, as there is no Multiple
Record Add Mode.
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The Field Attributes Screen
The Single Record and Multiple Record Field Attributes displays

can be accessed by pressing , from their respective data screens.

These Attributes screens control the display of data independently
of each other. For each of the data screens, you can select which fields
to display, and rearrange their order of appearance. Each line of the
Attributes Screen represents a field from the database file, or a
user-defined field. Use the Roll/Page keys to display all the fields in
the current record format.

The Attributes screens contain file information fields at the top of
the display. They perform the same functions as those on the data
screens. However, the Scan: field possesses additional capabilities
relevant to both the Attributes and Data displays.

Within the Attributes screen, //:(Scan) can be used to locate
a specific field name, and also to position the Data Display to that
field’s page location. The Attributes screen is also where the Scan

functions can be made field-sensitive on the Data screen. To restrict
the Scan function to one or more selected fields (up to 16), type S in
the first position of the Seq field(s) and press e. The Seq fields
will be redisplayed in reverse image. When the Scan functions (/
and :) are used on the Data screen, only the selected fields are
searched. To remove the field restriction of the Scan function, return
to the Attributes display, type D in each of the previously selected
field(s), and press e. The reverse-imaged Seq field(s) will return to
normal.

The Attribute Columns
Sequence The Seq column displays the sequence of the fields within the

display in multiples of five. This field is input-capable. A reverse image
sequence number indicates that the field is selected for scanning; lack
of a sequence number indicates that the field is not displayed.
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Page Number The Pg column displays the number of the page the field is on.
An underline indicates the end of each page.

Key The K column indicates whether the field is part of the file’s key,
and if so, which key position it holds.

Field Name The Field column displays the field name.

Type The T column displays the data type: alphanumeric (A), packed
(P), signed (S), etc.

Length The Len column displays the field’s length in characters.

Display Length The Dl column (not shown on 80-column Single Record Attributes)
shows the field’s display length. Change this field to alter the space
taken by the field on the Multiple Record display. Alphanumeric fields
will be extended or truncated on the right; numeric fields on the left.

Decimal
Positions

The Fd column displays the number of decimal positions defined
for the field. The Dd column displays the number of decimal positions
displayed on the Data screen. You may change this field to alter the
position of the decimal point on the Data screen display.

Edit Code The E column (not shown on 80-column Single Record Attributes)
displays the edit code for numeric fields. If no Edit Code has been
assigned to the field, a default value of L will be used. Although this
attribute affects both the Single and Multiple Record data screens, it
only appears on the Multiple Record Attributes screen. This field is
also input-capable. Refer to the Help Text or the User’s Guide for a
selection of the available Edit Codes.

From and To These columns (not shown on 80-column Multiple Record Attri-
butes) show the field’s starting and ending byte positions in the buffer.

Prompt Type The Prmpt column (132-column only) shows whether the field’s
single-record prompt is derived from column headings, field text, or
field name.

Color Codes These columns (Fc, Pc, and Hc, on 132-column only) show the field
(Fc), prompt (Pc) and column heading (Hc) colors (“Df” = default).

Protection The Prot column (132-column only), if set to Y, protects the field
from being changed on the Update and Add screens.

Auto-Duplicate The AutoDup column (132-column only), if set to Y, automatically
duplicates the previous entry for a field in Add mode.

Fields which have an entry in the Seq column will be displayed on
the corresponding data screen in the indicated sequence. You can blank
the Seq number to deselect a field from the data screen, or change the
number to alter the field’s position in the display sequence. When you
press e, the fields will be resequenced in multiples of 5, with
deselected fields positioned at the end of the list. You can reselect a
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field by assigning it a sequence number. This number will determine
the field’s position.

The ( key allows you to create your own field definitions for
externally and non-externally described files. Pressing ( will display
a pop-up dialog window allowing you to enter definitions for new
fields. Pressing $ will bring up a similar window, allowing you to
change existing field definitions. From either dialog, e saves the
definition and returns you to the dialog, while = closes the window
and returns you to the Attributes screen.

The Attribute Services Screen
By pressing * from either of the Field Attributes screens, you will

be taken to the Attribute Services display.

The Attribute Services display contains four Function Keys to
facilitate field selection on a broader scale. The Function Keys are:

/ will deselect all fields starting at the indicated sequence number
in the First sequence number to de-select field. If this field is blank, all fields
will be deselected.

: will select for display all fields currently deselected. They will
be given sequence numbers following the currently selected fields.

; resequences the fields alphabetically by field name.

? will copy the field sequence from the opposite Attribute screen
to the current one.

Extended Attributes and 80/132 Column
Attribute Services also contains a feature that allows changes to a

field’s column headings. A 1 in the Attributes/Extended Attributes
field selects the Attributes screen already discussed; a 2 selects the
Extended Attributes screen. The extended attribute columns for the
80-column Single Record Attributes screen are Prot and AutoDup. The
extended attribute columns for the 80-column Multiple Record Attri-
butes screen, and both 132-column attributes screens, are the respective
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first, second, and third line column headings. Additionally, the
132-column Extended Attributes screens show the Justification, Edit
Word, and 3-digit-year settings.

Each of the two attribute screens can be independently set for
normal or extended attributes; they retain their settings for the
duration of the QuestView session, or until changed from the Attribute
Services screen.

The Options Menu
From either of the Data screens, you may select the Options menu

from the Action Bar. The following are only a few of the options
available, grouped according to the Options menu items accessing them:

Screen
Formatting

Display file info controls display of the input-capable fields at the
top of the Data screens. If this option is changed to N, these fields will
not be displayed.

Display field names will substitute field names from the database
file for column headings on the Data displays.

Data Options Allow Display/Update/Add/Delete functions: If you select N for
these options, the corresponding functions will be disabled, and their
function keys suppressed from the display.

Print Options Record Images to Print on Update will provide an audit trail of
changes made to records from the Add and Update modes, and the
Delete function, either before or after changes, or both.

Scan Options Max no. of rcds (maximum number of records to scan at a time)
allows up to 999 records to be searched in a single scan function. The
larger the number of records specified, the longer the response time.

Scan Type (for numeric/full-field scan) allows you to change the
type of comparison used when scanning.

These are some of the most commonly used options. For an
explanation of other options available, press the +  key, or see the
QuestView User’s Guide.
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The Data Base Relations Screen
When viewing a file, you can display the Data Base Relations screen

by entering FD (Database relations on the File Menu) in the Action Bar
from either the Single or Multiple Data or Attributes screens and
pressing e, or by pressing ; from any of these screens.

This screen displays the logical files defined over a specified physical
file, or the physical files referenced by a specified join or multiple-for-
mat logical file, together with their key fields.

The File/Library table on the right displays the physical file first,
followed by its related logical files (or if the current file is a join or
multiple-format logical file, that file, followed by its related physical
files). The Key table to the left defines the key field relationship for
each file. The numbers in the heading, and the vertical stripes,
correspond to the file numbers and horizontal stripes in the file/library
table. The numbers in the body of the table indicate the order of the
key fields for each file, with the highest ordered key numbered 1. The
File/Library table contains a column of selection fields to the right of
each entry, allowing you to access one of these files. To open a specified
file, use the number 1. Once chosen, the file is displayed on the screen
from which you entered the Data Base Relations screen. To display
details about a specified file, use the number 5. To execute file-related
commands for a specified file, use the number 8.

Search and Replace
Pressing . from either data screen, while in update mode,

activates the Search and Replace Function, bringing up a simple
full-screen dialog with two entry fields, marked “Search For” and
“Replace With.” Pressing . or \ after entering the Search and
Replace strings replaces all occurrences of the Search string in the file
with the Replace string. If fields have been selected for the Scan function
(using the Field Attributes screen), only the selected fields are affected;
otherwise, all fields are affected.

12 QuestView™ Learning Guide
Copyright © Touchtone Corporation, 1996-2008



Global Update In addition, if exactly one field is selected for scanning, [ on the
Search and Replace screen will activate a Global Update function,
replacing the contents of the selected field with the Replace string,
regardless of the present contents of that field.

Program Creation
One of QuestView’s most useful features is Program Creation.Press-

ing , or pulling down Create A Program on the Program menu opens
a pop-up window allowing you to enter the specifications for a View
Program, which will capture all of the current QuestView settings in
a small program, which can then be called directly from the command
line, attached to a command, or called from any other program.

Once a View Program has been created, pressing ?, or pulling
down Load a Program on the Program menu, opens a pop-up window
allowing you to load the settings from any View Program for modifi-
cation. Once the settings have been loaded and modified to your
satisfaction, the program can be re-created the same way it was created
originally.

An Example of Program Creation
To illustrate program creation, try the following exercise: First, if

you are not already in QuestView, looking at the file “VIEWCUS,”
start QuestView as shown on page 3 of this guide.

Go to the Single Record Field Attributes screen, and remove the
sequence numbers from the CUSORT, CUSTDT, CUFIDT, and
CULIDT fields. Once you press e, the fields disappear, and move
to the bottom of the list. Then place the cursor on the line for the
CUZIPC field and press $. Then enter N on the line marked Edit
Code, and press e and =. Then press , to return to the data
screen.

Looking through the file, you should note that the fields you
removed are no longer appearing, and that zip codes beginning with
zero now show their leading zeroes. To freeze these settings into a View
program, press ^. A pop-up window will appear.

In the Program Name field, type TESTCUS. Press ̂  again. After
a few seconds, the window should disappear, and a message, notifying
you of the successful creation of the program, should appear. Press
# to exit QuestView, and type the following commands:

RCLRSC e

VIEW VIEWCUS e

Note that all settings have returned to their original default values.
Press # again to exit QuestView, and type the command:

CALL TESTCUS e

The QuestView data screen appears, with all the settings as they were
when the program was created, and the name of the program in the
upper right corner of the screen.
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ViewDemo
This exercise barely scratches the surface of what can be done with

View programs. To see an example of just how far one may go, try the
demonstration we have provided. From the command line, type

VIEWDEMO e

All of the screens in the demonstration are done with View
programs, with the single exception of one RPG program, the Parts
Master, which was done in RPG to demonstrate QuestView’s high-level
language interface. We have provided source code for this RPG
program and its display file, and left “observability” intact on it, so
that if you can understand RPG, you can easily see how a high-level
language program can be interfaced to QuestView.

New in Release 9.0
Undeleting a Record

QuestView 9.0 incorporates an Undelete feature, based on the
UNDEL2 technology developed by Dave McKenzie. Conveniently,
VIEWCUS includes several deleted records that you can recover.

To begin, return to a command line, and type

VIEW VIEWCUS e.

When the QuestView data screen appears, press * to get to the
Services screen, then press \ for Undelete. After several seconds of
processing, the following screen should appear:

Notice that the fields are shown with field names, and that the
record is flagged as “DELETED.” (If it is flagged as “ACTIVE,” you
can search for a deleted record with the < and > keys.)

Press \ to undelete the record. A message will appear asking you
to press \ again to confirm. After pressing \ a second time, some
processing will take place, and a message will appear, indicating that
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the record has been successfully undeleted (or not, as the case may be),
and the “DELETED” flag will change to “ACTIVE” (assuming a
successful undeletion). To return to the Questview data screen, press
#. You should now be able to find the undeleted record.

Using the Eclipse Client
This exercise requires the QuestView Server to be launched. If it is

active, a WRKACTJOB will show a job called VIEWSERVER. If it isn’t
running, you can launch it from the WRKVIEWINF utility, by
pressing the ^ key. (If your license doesn’t include this feature, the
“F6=Start Server” function key legend will not appear.)

You also need to have installed our plug-in client into your Eclipse
development environment. Once you have done so, you should be able
to locate and open the QuestView plug-in.

Initially, you should see a number of blank gray panes, and a Server
Connections pane that may or may not have connections already listed
(if you’ve just installed the plug-in, there should be none.) If you don’t
see a connection listed for your server, click the green plus-sign. A
window will appear, asking for connection information.Enter a name
for the connection, the IP address of your host, the port number(11092
is the default), your user-ID, and your password. Click the “Test
Connection” button to verify that you can connect.

Once you have a connection in your connection list, double-click
it. A progress window will appear, and after a few seconds, the red
square on the connection’s icon will change to a green arrowhead, and
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the “Libraries” pane will show a library/file/member tree, with all the
libraries you have access to. Double-click the AQUESTVIEW library
(it should be near the top). The database files in AQUESTVIEW should
then appear below the library name.  Double-click VIEWCUS, and the

“Data  View” pane should light up with something very much like the
Multi-Record data screen you saw earlier in this tutorial. You can scroll

the view to the left and right with the scroll-bar below the data, and
you can move through the records by clicking on the arrow buttons
above it, or by using the tabs of the Search pane below it.

At the lower right corner of the data pane is a legend: “Table View
- Display.” This is actually a button to activate a pop-up menu. If you
select “Form View - Display,” you will
get something very much like the Single
Record data screen.If the horizontal
scroll bar disappears, you can bring it
back by resizing the window slightly.

Next to the Search tab below the data pane, you’ll find a Database
Relations tab. At this point, clicking it just brings up an empty pane:
retrieving database relations is a relatively costly operation, whether in
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a terminal-based or client-server envitonment, and processing it to
provide the multiple views available in our Eclipse plug-in is also
somewhat time-consuming, so we only load this pane on request. Find
the Database Relations button over the data pane (it has an arrow
pointing to a file tree), and click it. A “Please wait” window will appear,
and then four tabbed views will appear under the Database Relations
tab.

The first tab shows a tree rooted in VIEWCUS, showing all logical

files that are at least partly based on it. Directly below
“AQUESTVIEW/VIEWCUS” you will see a notation that it is uniquely
keyed, and a list of its key fields, then the logical files appear below it,
listing their key fields. The “Table View” tab shows something very

much like the classic, terminal-based Database Relations screen, except
for two important differences: First, it’s a good deal easier to read, and
second, you can click on any field name, to shift the columns for the
files keyed to that field to the left.

The third and fourth tabs show tree views rooted in the CUNMBR
and CUSORT fields, showing which files have those fields as their
primary, secondary, and lower level keys.

The Field Attributes button brings up a Field Attributes window,
very similar to the Field
Attributes screen you’ve
already seen. Selecting and
deselecting fields for dis-
play is somewhat differ-
ent, though, as it involves
a separate pop-up window,
reached from the Field
Selection & Sequencing
button.

The Appearance button brings up a dialog that controls the
appearance of the data. As of Release 9.0, it only controls the number
of rows displayed. The Query Settings button brings up a dialog that
provides easy access to OPNQRYF, for simple queries. The CSV button

The Table View (right) and the terminal display (left)
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allows you to export data to a Column-Separated Value format, which
can be easily imported to spreacsheets and so forth, while the Print
button prints the displayed data locally.

For more details on how to use the QuestView Eclipse Client, please
see Appendix I of the QuestView User’s Guide.
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